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INTERMEDIATE INTRODUCTION

Course Description

This course covers the concepts and functionality you need to know in order to use the InEight Estimate
software successfully. As a result, you will be able to build cost estimates and bid proposals with
precision and efficiency.

Course Objectives

As a result of this course, you will be able to use the InEight Estimate software to:

l Review and report on project information

l Integrate with MS Excel and scheduling software (MS Project or Oracle Primavera)

l Manage quotes and use additional time-saving tools

How to Use this Manual

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

Lessons

The following lessons are covered in this course:



Course Lessons

Lesson Topic

Lesson 8 Quote Management

Lesson 9 Reporting

Lesson 10 Data Reproduction

Lesson 11 Excel Integration

Lesson 12 Schedule Integration

Lesson 13 Cash Flow

Lesson 14 InEight Estimate Calculators

Lesson 15 Cost Item Assemblies

Lesson Format

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Section Description

Objectives Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.

Step by
Steps

Walk you through the “mechanics” of how to perform specific functions in the software.
For each step by step, you will use the Training Job that comes pre-loaded in the InEight
Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will use the
Training Job that comes pre-loaded in the InEight Estimate Estimating software.

Review Asks you questions to check what you have learned within each lesson.

Call-Outs

Throughout the document, you will also find important call-out banners.

Tips are for important notes and information you want to remember.
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Notes are for critical information you need to know.

Ongoing Use

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 8 — QUOTE MANAGEMENT

Lesson Duration: 60 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items

Lesson Topics

8.1 Quote Management Overview 19
8.1.1 Quote Management Workflow 19
8.1.2 Quotes and Quote Groups 19

8.2 Requests for Quote 21
8.2.1 Request for Quote (RFQ) Register Overview 21
8.2.2 Request for Quote (RFQ) Record 22
8.2.3 Create an RFQ 23
8.2.4 Attachments 26
8.2.5 Setup 27
8.2.6 Publish an RFQ 27
8.2.7 RFQ Email Draft 32

8.3 Quotes 33
8.3.1 Sample Received Quote Scope Sheet 34
8.3.2 Quote Register Overview 35



8.3.3 Quote Record Overview 36
8.3.4 Header Block 37
8.3.5 Price Block 37
8.3.6 Quote Record Tabs 38
8.3.7 Data Blocks 38
8.3.8 Data Block Tabs 41
8.3.9 Create a Quote from RFQ 47
8.3.10 Enter Quote Details 49
8.3.11 Duplicating an Existing Quote 54

Exercise 8.1 — Quote Management 56
8.4 Quote Comparison & Award 58
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8.4.2 Edit Mode 59
8.4.3 Substitute Values 59
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8.4.5 Additional Quote Comparison and Award functions 64
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8.5 Scope Items 77
8.5.1 Scope Item Setup 80
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8.6 Quote Item Adjustment 91
Lesson 8 Review 95
Lesson 8 Summary 95
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8.1 QUOTE MANAGEMENT OVERVIEW

8.1.1 Quote Management Workflow

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract,
but rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:

1. Creating and publishing Requests for Quote (RFQs)

2. Updating quotes with vendor/subcontractor pricing

3. Comparing and awarding quotes

InEight Estimate has a separate form to manage each step:

1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award

8.1.2 Quotes and Quote Groups

Typically, an estimate contains two types of quotes:
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1. Quotes for resources (materials, equipment) purchased or rented from suppliers.

2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost item
level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

8.1.2.1 Resource Level Quote Groups

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:

8.1.2.2 CBS Level Quote Groups

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.
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8.2 REQUESTS FOR QUOTE

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or
services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the
line items you want to include in the quote, and the vendor(s) to whom you want to send it.

8.2.1 Request for Quote (RFQ) Register Overview

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

l The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response
Deadline Date
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8.2.2 Request for Quote (RFQ) Record

You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

Name Definition

1
RFQ
Description

Each record contains a Description, Deadline Date and Deadline Time fields to
identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the quote,
terms & conditions, and the seller companies to receive the RFQ.

3
Status and
Published
Data

The Status and Published Date let you know if it is new or published (sent out),
and when it was published.

Overview – Request for Quote (RFQ) Record
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8.2.3 Create an RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

l Create RFQ from scratch:  This creates an empty RFQ Record for you to define

l Create RFQ from Quote Group Tag(s):  This option lets you create an RFQ from a quote group
so you can add multiple materials or subcontract items at once

l Create RFQ using Default Seller data:  In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

The rest of this section walks through each tab on the RFQ Record in more detail.

8.2.3.1 Line Items

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,
Quantity, Quote Group, Currency and other user-defined tags.
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8.2.3.2 Terms & Conditions

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.

8.2.3.3 Seller Companies

You will use the Seller Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the InEight Estimate Library Address Book. This tab will
store all of the pertinent contact information for each seller, including their fax number and/or email
address so that you can send them the RFQ.
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The following options are particularly noteworthy:

l Publish Item Quantities:  If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

l Publish by Fax:  If you choose to publish by fax, InEight Estimate creates a Word document with
a template filled out. It is ready to print and send, but you have the opportunity to double-check
the information before emailing the RFQ

When RFQs are generated for multiple vendors using the Publish by Fax option, be
sure to separate the MS Word document pages and send only the correct pages to
each vendor.

l Publish by Email:  If you choose to publish by email, the Word document is created, the
template is filled out, it is attached to an email, and automatically sent to the email address
listed for that vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not
give you the opportunity to double check your information before the RFQ is
emailed. For this reason, it is recommended to Publish by Fax, review the
information, and then email the RFQ manually.

8.2.4 Attachments

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.
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8.2.5 Setup

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.

8.2.6 Publish an RFQ

Once created, InEight Estimate allows you to generate a Microsoft Word RFQ template that can be
faxed or manually sent via email to the supplier or subcontractor.
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When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ,
To do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the
RFQ Record ribbon.

Step by Step — Create and Publish an RFQ

1. Open your job.

2. From the InEight Estimate landing page, select the Quote tab.

3. Select Request for Quote (RFQ).

4. From the Actions tab, click on the New icon to create a new RFQ.

5. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
quote groups and resources that are being used.

6. Select a description from the panel.
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7. Click OK.

l The Request for Quote (RFQ) Record is created with two aggregate line items

l The Description field is automatically filled with the name of the quote group
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8. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 2:00 pm).

9. Select the Terms & Conditions tab.

10. Create and type in any special conditions in the Buyer’s Special Terms & Conditions field.

11. Type in instructions in the RFQ Instructions field.
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12. Select the Seller Companies tab and click in the first blank row in the Company Name column.

13. Click on the Address book icon, and then select vendors.

14. Click OK.

15. Make sure Publish by Fax is checked for all sellers, and that they all have Fax numbers.

l Also make sure Publish by Email in unchecked for each vendor

16. Select the sellers to whom you want to send the RFQ.

17. Under the Actions tab of the record, select Publish to create your RFQ document.

l MSWord opens the file automatically for you to review; and from here you can either
print it or send it in an email as an attachment
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18. Click OK to save the RFQ Record.

8.2.7 RFQ Email Draft

When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively
communicate the project requirements to potential subs or suppliers to ensure you have good quote
coverage within your estimate. Email RFQs open as a draft email message, giving you, the sender, the
opportunity to control specifically what is sent and customize the message before sending it out to subs
and suppliers.
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8.3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.
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8.3.1 Sample Received Quote Scope Sheet

Name Description

1 Section one

Scope item one includes 4 items the subcontractor has considered as work to
be done onsite. You may want to consider adding all 4 items as individual
quotes. Then creating a package identifying these quotes as on-site work,
totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as work to
be done offsite. You may want to consider adding all 3 items as individual
quotes. Then creating a package identifying these quotes as offsite work,
totaling $24,650.

3 Exclusions
The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If
selected all 3 are considered accepted terms.

Overview – Received Quote Scope Sheet
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8.3.2 Quote Register Overview

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.
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8.3.3 Quote Record Overview

The Quote Record establishes who the vendor is, along with quoted prices and all terms and conditions.
Once a requested quote returns, you can either create the quote in InEight Estimate from scratch or
convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each Quote Record
contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
quote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Name Description

1
Header
block

You can include detailed contact information about the supplier or subcontractor.
This automatically fills when you select the seller from the Address Book. The
External Ref field can be used to access information specific to the bid/quote.

2 Price
block

The Price data block contains a breakdown of pricing information for the quote,
including taxes, item conditions, and special conditions.

3
Quote
tabs

The tabs at the bottom of the screen hold detailed information regarding the quote.

4 Default
Data
Blocks

Data blocks include Special Terms & Conditions, Qualifications, Packages, Taxes,
Seller’s Profile, Setup, and Minority.

Overview – Quote Record
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8.3.4 Header Block

The Header block portion of the screen is where you enter in description information pertaining to the
quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote
attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

l Optional Code – a code used to reference the received quote.

l Date – date the quote is received.

l Source – this is the method by which the quote was received. The options are email, fax, hard
copy, phone, and other.

l Currency – system of money in general use for a particular country..

l Ignore – by ignoring the quote, and providing a reason, the quote will turn grey in the Quote
Comparison & Award screen.

8.3.5 Price Block

The Price block includes the quotes extended price, along with any additional taxes, bonds, item
conditions, and special conditions.
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8.3.6 Quote Record Tabs

8.3.6.1 Resources & Cost Items

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
quantities and units of measure.

l A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

l If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used

l Additional columns are provided for making conditional amount or percentage adjustments to
the quote to manage last-minute changes

l A note field is included for explanation changes

l A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

l You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

8.3.7 Data Blocks

The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back
to the default setting, which shows all six data blocks.

Data Block tabs include:

l Special Terms & Conditions

l Qualifications

l Packages
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l Taxes

l Seller’s Profile

l Setup

l Minority

The six data blocks appear at the bottom right of the screen.

It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.
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Drop the data block on top of an arrow where you wish to land the data block.

The data block will now reside on the left side of the screen.
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You can also close a specific tab if it’s not commonly used. In this example, you can right click on a tab
(like Special Terms & Conditions) and select close.

8.3.8 Data Block Tabs

8.3.8.2 Special Terms & Conditions

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.
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8.3.8.3 Qualifications

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.
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8.3.8.4 Packages

Using the Packages feature allows you a way to arrange quotes into a collection which makes sense for
packaging your quotes. You can determine how to intake quotes from subcontractors and classify them
into a package grouping.

By creating a Package code within the Packages block, and giving it a dollar value, you can then assign
that package code to one or many quote records. In this case, the subcontractor provided quotes for
both on site and off-site concrete work. You can then determine which individual quotes go with the on
site or off-site package. The Package Amount field carries over to the Extended Price field under the
Cost Items tab.
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You can also create a package by selecting multiple items and selecting Add to new Package.

8.3.8.5 Taxes

Item Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.

8.3.8.6 Seller’s Profile

The Seller’s Profile tab populates with address book notes and alternate contact information.
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8.3.8.7 Setup

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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8.3.8.8 Minority

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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If any of your Data Blocks become deleted on a Quote Record, simply click the Default
Data Block icon.

8.3.9 Create a Quote from RFQ

Walk through the steps of creating a quote from an RFQ.

To create a quote from scratch, click the New icon on the Quote Register and fill in the
quote details and seller fields manually.
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Step by Step — Create a Quote from RFQ

1. Open your job.

2. From the InEight Estimate landing page, select the Quote tab.

3. Select Request for Quote (RFQ).

4. Open the RFQ record for which you’ve received quotes (e.g. Aggregates RFQ).

5. Select the Seller Companies tab and select the sellers for whom you need to create quotes.

6. From the Actions menu, select Create Quote.

l InEight Estimate will create quotes for each of the sellers you selected
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l A prompt indicates how many quotes were created, then click OK

7. Close the RFQ Record and the RFQ Register.

8. To open the Quote Register, select Quote from the InEight Estimate landing page.

9. Select Quotes from the Quote Management section.

l The quotes that you created from RFQ are now listed on the Quote Register

8.3.10 Enter Quote Details

Now that you have quotes created, you can enter pricing.

Step by Step — Enter Quote Details

1. Open the Quote Record for a seller.

2. On the Resources tab, make sure No Split is unchecked for all items.
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3. Also on the Item Resources & Cost Items tab, now enter the following unit prices for the
resources:

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.00

MDIRTB Dirt Class B $6.00

4. Click OK to close the Quote Record.

Step by Step — Create a Multi-packages Quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.
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6. Click OK

7. Select the Cost Items tab on the left side of the screen.

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

1. Code: P1

2. Description: On Site

3. Amount: $200,000

4. Code: P2

5. Description: Off Site
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6. Amount: $300,000

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated package
quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
menu.
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8.3.11 Duplicating an Existing Quote

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

Step by Step — Duplicate an existing Quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.

l The resources and prices from the quote you previously selected have been copied into a
new Quote Record.

6. From the Header block, enter in any missing information.

l The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.
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l Check the default data blocks for any information you want to add to your duplicate quote.

8. Once done, click OK.
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Exercise 8.1 — Quote Management

When you receive quotes from vendors, you will need to record their pricing and conditions in their
InEight Estimate quote records. In this exercise, you will practice entering quote details. Enter the
following Quote Record details, using the Training Job:

Quote Name:
Aggregates

Seller Name: Example Vendor 2 - Stan Mark

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)

Special Instructions Seller is NOT willing to split items.

Quote
Name:
Aggregates

Seller Name: Example Vendor 4 - Lester Slim

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

Resource Code Description Unit Price

Quote Name: Aggregates Seller Name: Example Vendor 4 - Lester Slim

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

You should end up with the following results
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Congratulations, you have completed this exercise!
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8.4 QUOTE COMPARISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to determine
which is the preferred vendor or contractor to carry their pricing in your estimate. The Quote
Comparison & Award forms improve visibility into comparative analytics, while increasing efficiencies
in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It’s designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

8.4.1 Quote Comparison & Award Overview

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Name Definition

1
Resource and
Cost Item Filter

You can show either your quoted resources or cost items.

2 Quote Group
Filter

This section provides checkboxes to further filter your items. The Quote
Group Filter allows you to mark the quotes as reviewed.

3
Quote
Description and
Vendor

Your quotes display with the vendor name plus the quote description.

l Awarded items have an award symbol
If an item is designated as No Split, it has a chain link icon

l Awarded and Locked items have a lock symbol next to the award

symbol

4 Cost Source
Type

The cost source can either be a Plug or Detail type.

Overview – Quote Comparison and Award Form
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8.4.2 Edit Mode

You can make last minute modifications to the quote price directly in the Quote Comparison and
Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that
are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time
allowing you to see the impact of the changes in the estimate.

8.4.3 Substitute Values

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.
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When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

You can tell when it’s a substitute value because the price displays in italics.

InEight Estimate grabs the substitute value from one of four places:

1. Awarded splittable quote

2. Lowest splittable quote you’ve received

3. Detail (this only applies to quoting cost items)

4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
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these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote
Ranking in the colors sections.

Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute value
it displays the vendor whose substitute value has been used.

When you use a substitute value, it is included in your Comparable Total so you can have a more
realistic comparison of your quotes.
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8.4.4 Display Ignored Quotes

You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.

From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.
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If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote cannot
be awarded. The ignored quotes get appended to the right end of the QC&A form.
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8.4.5 Additional Quote Comparison and Award functions

The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Name Definition

1
Asterisk next to
Quote Item

An Asterisk (*) is displayed on a quote to indicate when that quote includes
quote items appearing in other Quote groups.

2 Zero value
Plug/Detail

Award quotes to Plug or Detail when its value is zero.

3
Updated Quote
Items Tool tip

Quote Item Tool tip displays details including:
l Unit Price
l Extended Price
l Bond
l Taxes
l Special Conditions
l an indicator for a delta quote item

Overview – Additional Quote Comparison and Award Functions

8.4.6 Configure Totals

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.
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The Options radio button give you better control for viewing totals at the tops of the screen or after the
quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.
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8.4.7 Adding Notes to Quote Comparison & Award

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
quote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.

Step by Step — Add the Notes section to Quote Comparison & Award form

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

l Notice the absence of the Notes section. This is the default option until you follow the next
steps.
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3. Select the Actions tab.

4. From the View section, select the Configure Totals icon.

5. Select the check box in the Visible column for the Notes caption.

6. Select OK.
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l The Notes section displays on the Quote Comparison & Award form.

8.4.8 All Quote Groups Layout

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

You can make appropriate quote group selections based on understanding how choosing a quote group
impacts the entire estimate. In addition, the quote groups layout provides you with the visibility and
flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:

Name Definition

1
Totals per Quote
Group

Ability to see the Awarded Total Plug, Detail and Quote amount per
Quote Group

2 Total Awarded
Amount

Visibility into the Total Awarded Amount per Quote Group

Overview – Quote Groups Layout
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Name Definition

3 Comparable totals Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the quote
items

Overview – Quote Groups Layout (continued)

You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

8.4.9 Compare and Award Quotes

To award an item, right click on that item and select Award.
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The Award icon displays next to the awarded item(s).

Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.
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You can award multiple Quote items by selecting all the items and then using the right
click context menu to award.

8.4.9.1 Open Status

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
quote record, will turn the record back to gray.

8.4.9.2 Award Status

The Award Status indicates whether or not all quotes are awarded within a quote group.
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8.4.9.3 Review

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
quote group will be highlighted in yellow to indicate something changed since the last review.

Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

Step by Step — Compare and Award Quotes

1. Open the Training job, and from the main InEight Estimate landing page select Quote>Quote
Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.
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3. Under Description, select Asphalt Materials.

4. Review the quotes to determine the lowest bidder:

l Select the Configure Total icon in the tool ribbon to view additional captions

l Both vendors have no split items for both resources.
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5. Example Vendor 1 has the lowest comparable amount, so award all to Vendor 1 by right clicking
on the Example Vendor 1 Asphalt Materials and selecting Award All.

l By awarding Example Vendor 1 both resources, the award ribbon icon displays next to the
unit price.
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l You could also change your mind and award Example Vendor 2 one of the resources. In
this case, award resource code MAFA to Example Vendor 2.

6. Right click on $7.35 under Example Vendor 2, and select Award.

l You now have awarded resource code MAFA to Example Vendor 2.

8.4.10 Package Entire Quote

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial
if you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.
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8.4.11 Incomplete Quotes

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not provide
their prices until right before the bid is due. These quotes display in gray in the Quote Compare and
Award form.

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are
displayed to the right of all the Comparable Quotes.
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8.5 SCOPE ITEMS

During the bidding process, it’s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items, you
can create and evaluate checklists and quote group exclusions, and account for them within the Quote
Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Section Description

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting the checkbox, you can
indicate scope items and uncheck items that are not included. The amount associated
with these items will then total up in the Special Conditions subtotal. The person
responsible for awarding quotes needs to update the Inclusions field to correspond with
what the subcontractor has agreed to include in the quote.

Overview – Quote Record – Scope Items
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Section Description

1 Scope Items

Quote Comparison and Award checklist items for your quote that help with
evaluating subcontractor and supplier quotes in greater detail. This is used to
ensure certain items are either included (inclusion) or excluded (exclusion) in
the quote and accounted for by the entity awarding the quote.

2 Scope Item
Inclusions

Maintained in Quote Record form. These are the Seller’s Special Terms &
Conditions scope items that the subcontractor is including in their quote price.
When the scope item contains a value, the subcontractor is agreeing to perform
the work. 

3
Scope Item
Exclusions

Maintained in Quote record form. These are the Seller’s Special Terms &
Conditions scope items price. If the Inclusions checkbox is blank, the

Overview – Quote Comparison and Award – Scope Items
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Section Description

subcontractor is NOT agreeing to perform the scope items.

4 Scope Item
value

An entered value means that the subcontractor is excluding this scope of work.
However, you may add an amount because this scope could incur a cost. Once
the bid is awarded, you may find another subcontractor to perform the work.
You are simply accounting for a cost for this scope of work. In the example
below, HD Engineering is not going to paint the electrical equipment, but you
know the cost is $150.00. You are showing this cost to account the cost for this
scope of work that needs to happen.

5

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting this checkbox, you
can indicate scope items and uncheck items that are not included. The amount
associated with these items will then total up in the Special Conditions subtotal.
The person responsible for awarding quotes needs to update the Inclusions field
to correspond with what the subcontractor has agreed to include in the quote.

Overview – Quote Comparison and Award – Scope Items (continued)

The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best value.
In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the best
quote to go with.
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The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

8.5.1 Scope Item Setup

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each Quote
Group Tag Record, you can list out scope items that break down the work into smaller scopes of work,
along with the estimated cost amount associated with each scope item.

Page 80 of 259 InEight Inc.  |  Release 20.2

8.5 Scope Items Estimate Intermediate User Guide



8.5.2 Scope Item Creation and Award

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

Step by Step — Create and Award Scope Items

1. Open the Training Job.

2. Select the Setup tab.

3. Click on Foundation Data Setup in the Initialize section.

4. Select the Quote Group Tags tab to setup Scope Items within a Quote Group.

5. Create a new Quote Group Tag called Electrical Work and click OK.
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6. Open Electrical Work and add the following Scope Items:

l Permits

l Surveying and Layout

l Temporary Traffic Control Devices

l Trench and Backfill for Electrical Work

l Painting Electrical Equipment

l Temporary Power and Lighting

7. Enter 500 in the Amount field for Survey and Layout, and 300 for Temporary Power and Lighting.

l If any of these default columns are missing, click on one of the headers, and right click.
Select Column Chooser and drag the item(s)over tto the header bar, then click OK
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8. Click OK.

9. Select the Estimate tab.

10. Click on Cost Breakdown Structure (CBS).

11. Change your Saved Views to Quote Group Setup View.

12. Create a cost item Entry Gate with a subordinate Electrical Work.

13. Assign Quote Group Electrical Work to the Electrical Work cost item.

14. Select the Quote tab.

15. Click Request For Quote (RFQ) to open the RFQ Register.

16. Create an RFQ for the Electrical Work cost item by selecting the New icon on the Actions tab.

17. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.
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18. Click OK.

19. Click on the Seller Companies tab and select the following Company Names:
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l Architectural Designs

l HD Engineering Group

20. Highlight both companies and select Publish.

l Make sure the appropriate boxes are checked and fields filled out for publishing either by
fax or by email prior to publishing

21. Assuming that you’ve already received quotes back from both companies, create a Quote from
this RFQ for both companies by selecting the companies and selecting Create Quote.
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22. Click OK to close the RFQ record.

23. Select the Quote >Quotes tab to open the Quote Register.

l Note the 2 quotes that were just created for Electric Work

24. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500, which is
based on the quote you received.
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25. Select the Special Terms & Conditions tab and select the Seller’s Special Terms & Conditions
radio button.

l You now have visibility for all of scope items for this quote

26. Assuming HD Engineering is excluding certain scope items from this quote, click on the Included
checkbox to exclude (uncheck) the following scope items:

l Surveying and Layout

l Painting Electrical Equipment

l Temporary Power and Lighting

27. Type 150 in the Amount field for Painting Electrical Equipment.

l Notice how the 3 scope items you just excluded are now added to the Special Conditions
total for the quote
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28. Click NEXT to move to the other Quote Record for Architectural Designs.

29. Enter a Unit Price of 3,700.

30. Press Tab to move to the Special Terms & Conditions tab and select the Seller’s Special terms
& Conditions (at right) radio button.

31. Uncheck the Inclusions checkbox for Surveying and Layout

32. Add the amount 500.

33. Click OK.

34. Select the Quote tab.

35. Open the Quote Comparison and Award form, and select the Cost Items tab.

36. Under Quote Groups, select Electrical Work.
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l You will notice that scope items with inclusions and exclusions on the quotes are now
displayed in the Scope Items section. The Scope Items button needs to be pressed in the
View section of the screen

l The total of all exclusions are now added to the Special Conditions section for each
subcontractor

If your Special Conditions row is missing, click the Substitute Values icon on
the Action tab. You can also rearrange the sequence as desired.
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l Most importantly, this comparison including scope items makes it clear HD
Engineering Group has provided a quote of $4,450, while Architectural Design’s
quote is $4,200

37. Right click on the quoted amount for Architectural Design and select Award to award the work
to Architectural Design.

38. Click Yes, on the resulting prompt to mark the quote group as reviewed.
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l The Architectural Design’s quote is now awarded

8.6 QUOTE ITEM ADJUSTMENT

Quote items can be adjusted even after a quote has been awarded. This could happen on closing day
when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on
piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the
Condition Adjustment column.

Step by Step — Quote Item Adjustment

1. From the Ribbon, select the Quote tab.

2. Under the Quote Comparison and Award section, select Resources.
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3. Locate the Example Vendor 3 column.

4. Select the quote you want to edit under the Example Vendor 3 column. In the Ribbon, select the
Actions tab.

5. Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote. This
launches the Quote Record.

6. You can make Condition Adjustments by a percentage or an amount. Select the field to adjust the
percentage or amount of the Condition Adjustments.

If you enter a percentage, the amount is populated based on that calculation. This
is the same for entering a Condition Adjustment Amount.
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7. Items adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

8. As you populate the 10% discount adjustment to all of the items selected using the multi-edit
tool, the amount value changes to Varies. This is because of the variance in the unit rates for
each selected item.
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9. Select OK to save the changes to the line items in the Quote record and to save the Quote.
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Lesson 8 Review

1. When you receive responses to your RFQ, the next step is to enter their pricing in the
__________________.

a. CBS Register

b. PBS

c. Quote Register

d. RFQ Register

2. On a Quote Record, No Split means

a. The quote must be combined with other quotes from the same vendor

b. All items on the quote must be purchased from that seller

c. You can’t split the quote into multiple quotes

3. When a quote group is highlighted in yellow on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed

b. No quotes have been awarded for that quote group

c. There are some quotes in the quote group that contain substitute values

Lesson 8 Summary

As a result of this lesson, you can:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items
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LESSON 9 — REPORTING

Lesson Duration: 30 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Run reports from the Reports menu

l Create and run reports from register forms
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9.1 REPORTS MENU

InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,
that can help you review and analyze your estimate.

9.1.1 Non-Modal Report dialog box

The Reports dialog is docked along with the other forms and registers. You can continue to work with
your estimate without being forced to close the Reports dialog box.

If the report becomes undocked, the job code shows in the reports dialog box header.
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9.1.2 Adjustable Reports

Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting
format you need. Each report has its own set of output settings for configuring and formatting the
report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the
same report multiple times and choose different output settings based on what you want to see or who
the intended audience is.

For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report
recipients want to see.

l For a group of estimators, you may want to run a CBS Details Report that shows all cost and
productivity data for a job

l For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

l Finally, for executive management, you may want to run a CBS Details Report that shows
summary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.

Step by Step — Get to Know the Reports Menu

1. Open the Training Job, and select Setup tab.

l You access the Reports menu by clicking on the Reports icon

You can access the Reports menu from the Setup, Estimate, Quote, Price, and
Execution tabs.

2. Select Reports.
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3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.

l You will see a split screen with the reports available on the left side bar

l The side bar on the left of the Reports form contains a “tree” of all InEight Estimate
adjustable reports
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l On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.
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l There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
reports

9.1.3 Output Settings

This section provides a more detailed explanation of the output setting tabs.

9.1.3.1 Report Printing Options

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

9.1.3.2 Report Layout Settings

Many of the InEight Estimate adjustable reports include formatting options for the general layout of
the report, located under the Layout tab of the report’s output settings. Settings for the report include:
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Orientation, Margins, Font, and Number Format.

9.1.3.3 Report Header/Footer Settings

Many of the InEight Estimate adjustable reports include the option to define and insert headers and
footers into the report. You can add information to the left, middle, or right of the header and footer
sections of the report.

1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.
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4. You can enter your own information as desired.

9.1.3.4 Report Detail Settings

Most reports have a Details tab with various options to configure what information is included on the
report.
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9.1.3.5 Save Output Settings

Once you’ve configured your settings for the report, you can save them as a custom version of that
report.
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The following steps walk you through configuring the settings and formatting for two different reports.
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Step by Step — Configure Report Output Settings (Report 1)

1. Open the Training Job and select Setup >Report>Resources.

2. Under Resources on the left side bar, select Resource Utilization.

3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.
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4. On the Layout tab you can make adjustments based on your preferences.
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5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear
on the first page only.
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6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.
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l You can choose to select the Hide Zero quantity/cost Resources Employments Details box if
you prefer to have your printed report not show any resources that have a dollar value of
zero

l You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

l If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS position
to the structure of the report

l You would select this if you wanted to see cost items and resources by the cost item

The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.
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l For this example, you will not make any selections under Columns or Details

l This is just one of many ways to organize and adjust your report.

11. Click Run to run the report.

l This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

Step by Step — Configure Report Output Settings (Report 2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.
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2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.
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3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

4. The Cost Item Selection tab allows you to report on a selection of cost items:

l Print a contiguous range of cost items:  Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

l Select cost items to print from the register below:  Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, andMan-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential –Internal Use
Only.

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output
setting tabs.
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11. Select the Save disk icon to save the new settings.

12. Type Estimate Summary – Manager.

13. Click OK.

l Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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9.1.4 Helpful Reports

9.1.4.6 PBS Summary

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:

l Cost Categories

l Markup Rate

l Percentage of Cost

This allows you to see your costs and markup broken out by cost category.
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You can also select to show markup rate and what percentage the markup is of your cost.

9.1.5 Standard Proposal

Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for
contractors required to submit a pricing proposal to a client. It lists all the pay items with the client
provided quantities and your final pricing. You can include subtotals (defined on the Pay Item &
Proposal Register), cover sheet information, and a signature block.
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9.1.6 CBS Details

Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS
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Register, including cost items with production, costs by category, shift arrangements, resources, and
notes.

9.1.7 Audit

Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors
in the estimate, including:

l Zero Price Pay Items

l Zero-value cost items

l Pay items without Cost Items assigned

l Resources with a quantity of zero
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Exercise 9.1 — Run a System Report

You can adjust InEight Estimate system reports to report on the particular information you need.
Complete the following steps to configure and run the Pay Item Summary report, using the Training
Job:

1. From the Reports window, expand the Pay Item & Proposal report node.

2. On the Reports tree, select Pay Item Summary.

3. On the Details tab, select a Pay Item Range from 303 4263 – 800 0220.

4. Choose to Include Assigned Cost Items.

5. Show Costs As: Unit.

6. Include Profit Analysis columns and Include Pay Item Price columns

7. Run the report.

You should end up with the following results
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Congratulations, you have completed this exercise!

Page 122 of 259 InEight Inc.  |  Release 20.2

Exercise 9.1 — Run a System Report Estimate Intermediate User Guide



9.2 REGISTER REPORTS

At any time, you can print a report of the data in the currently displayed register using the Print or
Preview option available from the Actions tab for the register you are in.

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on
resource utilization and saving it as a Saved View.
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Step by Step — Create a Register Report

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.
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4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.
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6. From the Customization window, drag-and-drop the Minority Percent, Unique Sales Tax, (Scale
2), andMaint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.
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l This sorts your items so the most utilized resources are at the top

9. Click on the Saved Views drop-down menu and select the Save disc icon to save the view.

10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actionsmenu, select Preview to review the report before printing.
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9.2.1 Register Report Output Settings

Within the Preview for a register report, there are several options to choose from to configure the
output of your report.

9.2.1.1 Page Setup

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:

l Page Size (legal, letter, etc.)

l Paper Width & Height

l Orientation (portrait or landscape)

l Page Margins (left, right, top, bottom)

9.2.1.2 Exporting to Document

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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Exercise 9.2 — Create a Custom Register Report

You can configure the columns in your registers for reporting and run your own custom reports.
Complete the following steps to configure and run a report from the CBS Register, using the Training
Job:

1. Select Estimate>Cost Breakdown Structure (CBS).

2. Under Saved Views, Select CBS Simple View.

3. Hide the Optional Code column.

4. Add back in the Man-Hours (Total) andMan-Hours / UM columns.

5. Now add back in the Labor Total Cost, Owned Equipment Total Cost, and Materials
Total Cost categories for reviewing the estimate.

6. Save the View (create your own name for the view).

7. Select Preview to view the report.

You should end up with the following results

Congratulations, you have completed this exercise!

InEight Inc.  |  Release 20.2 Page 129 of 259

Estimate Intermediate User Guide Exercise 9.2 — Create a Custom Register Report



Lesson 9 Review

1. The ___________ Report gives a good overview of how your price breakdowns by cost
category.

a. Estimate Summary

b. PBS Summary

c. Audit

2. The ___________ Report is a very important report to run during bid review to make
sure you didn’t leave anything out of the estimate.

a. CBS Details

b. Audit

c. Pay Item Summary

3. A best practice is to always set your Print output setting to Preview so you can review
before printing.

a. True

b. False

Lesson 9 Summary

As a result of this lesson, you can:

l Run reports from the Report menu

l Create and run reports from register forms
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LESSON 10 — DATA REPRODUCTION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create a job from an existing job or template

l Create a template

l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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10.1 COPY AN EXISTING JOB

As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of
the existing job.

Using the Create a new Job from… Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

Step by Step — Copy an Existing Job

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Existing Job.

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.

InEight Inc.  |  Release 20.2 Page 133 of 259

Estimate Intermediate User Guide 10.1 Copy an Existing Job



4. On the New Job dialog, in the Code field, type Infra Job Copy with your initials.

5. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

l If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

6. Uncheck the check for copying the PBS Changes Log.

7. Click OK to create the new job.

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.

This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.

10.2 TEMPLATES

Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the
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estimating process increases to ensure consistency and reduce the chance of information being
overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.

Step by Step — Create a Template

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.
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4. From the Actions tab, select Create Template from Job.

l The Job Register opens for you to select the source job for the template

l Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.

You cannot create templates from jobs that are published to Job Tracking.
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l A prompt appears to give your new template a Job Code

6. In the Code field, type Small Project Template[your initials].

l Leave Copy Cost Details and Copy PBS Changes Log checked

7. Click OK.

l The new template is created and opens to the Job Properties form

l You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job
Properties form

l Back in the Templates Register, you can see the new template created
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l Similar to copying an existing job, you can create a new job from a template from
the New menu in the Backstage View.

l You can also create a new job from a template from the New menu in the Bid
Wizard.

8. Select Add to existing job

9. From Select Source Job, click the dropdown arrow

10. Click Next

11. Select a job that is shown as having a Template

12. Click OK
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10.2.1 Archive and Restore Templates

The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

Step by Step — Archive and Restore a Template

1. Click File to open the Backstage View.

2. Select Archive / Restore.

l Several options appear for archiving and restoring your jobs, templates, and library

3. Select Archive Template.

l The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.

8. Browse to the archived template and select it.

9. Click Open.
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l If the template already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Template Code

10.3 BID WIZARD

InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up
estimates by copying information that already exists in other InEight Estimate job folders. The Bid
Wizard can be used to create new projects, create a new job from an existing template, or to add to
projects that are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and control
over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are
commonly used, you can copy them into a new project. If you select pay items, you will be able to
select cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

Step by Step — Use the Bid Wizard

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Bid Wizard.
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l The Bid Wizard – Step 1 dialog displays

Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.

4. Type Bid Wizard Example in the Description field.

5. Click the Next button.

l The Bid Wizard – Step 2 dialog displays

6. Choose Select cost items and click Next.
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l The Bid Wizard – Step 3 of 4 dialog displays

l You use this step to indicate which source you want to pull your setup data from (the
library or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.
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10. Click Next.

l The Bid Wizard – Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.
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l The Job Register opens

12. Find and select Training Job.

13. Click OK.

l This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.
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15. Select the checkboxes to include Mobilization, Clearing & Grubbing, and Unclassified
Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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17. Click Finish to add the new job.

l An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift
Arrangements of the copied cost items?”

l Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.
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19. Click OK.

l A help bubble appears letting you know the job has been created, and that you can use the
ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

21. Open the Estimate > CBS to see the three cost items that were brought in.
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10.3.1 Bid Wizard Updates

While using the Bid Wizard, the Include option is left unchecked by default. A filter is applied to bring
in pay items when using the Bid Wizard. The Toggle Include All button only selects the filtered list of
items instead of all items.

When the filter criteria is modified, the selected items remain checked even if some of the items
might not be visible in the view. When the view is changed, the selected items remain checked.

Tags and UDF fields are included in the Bid Wizard Selection register for the cost items and Pay Item
& Proposal selection registers. This lets you filter the list of cost items based on a tag or UDF.

When you select the Toggle Select All button, only filtered items are included which allow you to
include scopes of work relevant to your estimate without having to manually select all items needed.
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10.4 COPY ESTIMATE DATA USING EDIT COMMANDS

While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

Step by Step — Copy Estimate Data Using Edit Commands

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).
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3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using the minimize icons of each job or utilizing Windows align functionality.
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l Note that the window caption identifies the CBS Register for each job

5. On the CBS of the Training Job, click the row header on cost item 4 – Aggregate Base and press
Ctrl+C to copy the cost item.

When you copy a superior cost item, all of its subordinates are automatically
copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.

7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.
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l You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail

You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.
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10.5 CBS BID WIZARD

You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.

Step by Step — Use the CBS Bid Wizard

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.

2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS

4. Highlight the New row.

5. To open the CBS Bid Wizard, click the Bid Wizard icon on the More Actions tab.
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l The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.

7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

l A source CBS Register window appears

9. Select CBS position code 5 – Asphalt Concrete Hot Mix Type A from the register.

10. Click OK.

11. Click Finish on the Bid Wizard.
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l An Attention prompt displays, asking if you want to make adjustments

l Keep the default options selected:Make Adjustments according to their quantity
drivers and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

l You can see that cost item 5 and its subordinates are now imported into your existing job.

l You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item

10.6 SNAPSHOTS

A job snapshot is a copy of an estimate that provides read-only access to the job as it existed at a
specific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

10.6.1 Snapshot Register

The Snapshot Register is where you will view individual snapshots for specific jobs.
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Step by Step — Snapshot Register

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.
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10.6.2 Creating a New Job Snapshot

Step by Step — Create a New Job Snapshot

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.

2. If an existing job is open select Save, if you haven’t already done so.
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3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.
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10.6.3 Editing a Job Snapshot

Step by Step — Edit a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.
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10.6.4 Deleting a Job Snapshot

Step by Step — Delete a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select Delete.

3. Click OK

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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10.6.5 Loading a Job Snapshot

When you load an existing Snapshot, it loads into Estimate as any other job.

Step by Step — Load a Job Snapshot

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.

4. Right-click on the individual snapshot you want to load and select Load.
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To identify a snapshot in Estimate as a read-only snapshot:

l The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

l A red banner shows the specific snapshot information at the bottom of the screen

A snapshot can be modified, but it cannot be saved as it is read-only.
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Exercise 10.1 — Data Reproduction

Now that you have learned how to utilize the Bid Wizard, complete the following steps using the Bid
Wizard and Copy & Paste features.

1. Open the Bid Wizard by clicking the Bid Wizard icon from the More Actions tab.

2. Choose the Create a new job radio button.

3. Type BW Exercise (with your initials) in the New Code field and type Exercise in the
Description field.

4. Choose Select cost items.

5. For all selections, choose Copy from source job.

6. Select the Also copy all non-utilized resources checkbox.

7. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy
Markup box is automatically selected.

8. Find and select Training Job and click OK.

9. Use the Toggle Include All button to exclude all selections.

10. Select the checkboxes to include Cost Items 4-7.

11. Click Finish to add the new job.

12. Select Adjust the pay rules and shift arrangements to match the destination.

13. Open the CBS to see the cost items that were brought in.
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14. Open the Infra Job Copy with your initials that you created earlier in this lesson.

15. Copy Cost items 8 and 9 and paste them into the BW Exercise job.

You should end up with the following results

Congratulations, you have completed this exercise!
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Lesson 10 Review

1. From the New option on the Backstage View, which of the following options are available
for creating a new job? (Select all that apply)

a. Scratch

b. Template

c. Import

d. Existing Job

e. Historic

f. Bid Wizard

2. Which of the following job reproduction options lets you pick and choose which cost items
you want to import into your new job?

a. Template

b. Bid Wizard

c. Existing Job

d. Archive

3. Which of the following options allows you to add cost items from another project when
working in the CBS Register?

a. Bid Wizard

b. CBS Bid Wizard

c. Template

d. Existing Job

Lesson 10 Summary

As a result of this lesson, you can:

l Create a job from an existing job or template

l Create a template
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l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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LESSON 11 — EXCEL INTEGRATION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data
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11.1 LINKING TO EXCEL

11.1.1 InEight Estimate Workbook

Every job has its own Excel workbook embedded within it for doing side calculations and take-offs. You
can link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new
embedded Excel workbook for the job.

The workbook comes with some pre-defined take-off and analysis worksheets, or you can create your
own. Simply open the appropriate worksheet, plug in your values, and Excel will calculate your results.
To open your job’s workbook, select the Estimate tab, then click on the Workbook icon under the
Workbook section.
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l The embedded Excel workbook for the job opens.

11.1.2 Linking to and from Excel

InEight Estimate's linking capabilities with Excel can be done in one of two ways. A field in InEight
Estimate can be populated with a value from Excel, or a cell in Excel can be populated with the data
from an InEight Estimate field. This two-way linking functionality allows you to make quick work of
complex chores to perform spreadsheet-based take-off or formula-driven analysis.

The following example walks through how to link a simple take-off calculation into InEight Estimate
from Excel. It is a take-off to determine the size of a concrete foundation.
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Step by Step — Link Estimate to Excel

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

3. Open the job’s Excel workbook from the Estimate tab, by selecting the Workbook icon.

4. In the workbook, create a new worksheet named Concrete Take-off and enter the following
fields:

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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l Your Volume Total should be 50 cubic yards

6. InEight Estimate will only link to named fields in Excel. Click in the field you want to name (B6),
then click in the Field Name window and type Volume.

7. Go back to the CBS Register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Excel.

l You can also link the field by selecting the field and then selecting Link Field from the
Actions tab
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9. On the Link to Excel dialog, select the Update InEight Estimate field from Excel radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh button for the
field name to display).
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11. Click OK.

l The Forecast Quantity field for Concrete now is linked to the Volume field in Excel and
populates with the take-off quantity (50)

11.1.3 Update Links

When data in InEight Estimate or Excel changes, you can quickly update all links, in just the currently
active job or in all open jobs.  Simply select one of the following options from the Workbook drop-down
list on the Estimate tab.
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11.2 BUILT-IN SPREADSHEET

Most of the time, a cloud-based deployment of the Microsoft Office products, including Excel, are
installed on new laptops or machines as the default installation option for Office 2016. Estimate's Excel
integration relies on an on-premise (according to Microsoft) installation of the Microsoft Office
products.

Estimate supports the option to use spreadsheet control for those that do not have the on-premises
version of Microsoft Excel installed. You can switch between the Embedded workbook and the
spreadsheet control from the Configuration Tool.

This option lets you use the functionality of the embedded workbook without having an on-premises
installation of Microsoft Excel.

Follow the step by step below to change to the Built-In Spreadsheet option.

Step by Step — Built-In Spreadsheet

1. From the Windows Start Menu, search for Configuration Tool. The Estimate Configuration
window opens.
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If Estimate has been directly installed on your machine, the Estimate Configuration
window will appear. If you cannot find your Estimate Configuration, contact
support.

2. Select the File tab.

3. Under the Spreadsheet data box, select the Spreadsheet Application drop-down arrow.

4. Select the option Built-In Spreadsheet.
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11.3 CURRENCY IN JOB TRACKING EXCEL IMPORT

The currency function lets you import actuals in different currencies while you work in multiple
currencies within a job.
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Lesson 11 Review

1. The Export to Excel feature is available on all register forms in the system and allows you
to export the data currently displayed on a register form to an Excel worksheet.

a. True

b. False

2. You can use the __________ tool to easily select a group of items to copy.

a. Customize

b. Workbook

c. Cell Select

d. Excel Select

3. In order to link an Excel field to InEight Estimate, the Excel field must be:

a. Named

b. Highlighted

c. Tagged

d. Selected

Lesson 11 Summary

As a result of this lesson, you can:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data
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LESSON 12 — SCHEDULE INTEGRATION

Lesson Duration: 45 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Set up scheduling options

l Update schedule from InEight Estimate

l Update InEight Estimate from schedule

l Manage changes between estimate and schedule
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12.1 PRIMAVERA

12.1.1 Scheduling Options

Prior to sending information from InEight Estimate to Primavera, you need to make sure the proper
settings are in place.

12.1.1.1 Job Properties Schedule Tab

Primavera scheduling options are configured on the Setup > Job Properties > Schedule tab.

l At the top of the Schedule tab, the Integrated Schedule must be set to Primavera

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Primavera to change the duration and therefore the cost
of your cost items in InEight Estimate)

l On the Schedule tab, there are several sub-tabs that need to be set up correctly to produce
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correct data behavior and ensure the correct passing of data to Primavera

Step by Step — Login Options Tab

1. On the Schedule > Login Options tab of Job Properties, select the Use these login settings radio
button.

l If pre-defined login settings were required, the Use pre-defined login settings radio button
would be selected instead

l The Instance will remain set to -Default-

l Database selection will be pmdb during training.

2. Type your user name in the User Name field.

3. Type your password into the Password field.

l You will have your own login settings specific to your company
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12.1.1.2 Mapping Options Tab

The Mapping Options tab contains options critical to downstream applications. It will have the
following settings selected by default:

1. The CBS Position Code is selected as the field to populate the Primavera WBS Code and Activity
ID fields.

2. The Manage the Primavera WBS structure in InEight Estimate… radio button is selected for
the initial push from InEight Estimate to P6.

l This means the WBS structure in Primavera will be controlled by the structure of superior
and terminal cost items in InEight Estimate.

l Selecting the other option would cause the WBS structure to be controlled in Primavera.
Only terminal cost items would be sent from InEight Estimate to Primavera and all
hierarchal structure (WBS Elements) would be created in Primavera manually

l This option can be changed later, on a job-by-job basis.

3. The Update the Project’s Planned Start Date in Primavera from the Forecast Start Date
option is checked.

l This will automatically pull the Forecast Start Date from the Job Properties > Cover Sheet
tab to become the Planned Start Date in Primavera.

You should double-check to make sure the right Start Date is defined on the
Job Properties > Cover Sheet tab.

12.1.1.3 Resources Tab

The Resources tab dictates how resources are mapped between InEight Estimate and P6.
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Section Name

1
Update Primavera Resources
from Estimate

Provides options for sending InEight Estimate resources to
Primavera.

l Typically, you would select the Update scheduled
resources only option to send only resources that are
employed on cost items

l The Update all of this job’s resources option updates
Primavera with all of the resources in your project’s
Resource Rate Register

2 Map Resource Types to
Primavera

Specify whether your resources will import into Primavera as
Resources or Roles.

3
Update Primavera Budgeted
Units when using Plug Days

Allows you to specify how to handle Budgeted Units for items
that use Plug Days.

4 Update Primavera Cost
Accounts from Estimate
Account Codes

Checking this box causes assigned account codes to import into
Primavera as Cost Accounts.

5
Update Price/Unit on
Primavera Resource
Assignments

Checking the boxes in this section will cause the Charge Rate
costs of your resources to import into Primavera along with
your resources.

12.1.1.4 Overview – Resources Tab
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12.1.1.5 Expense Costs Tab

The Expense Costs tab is useful for bringing costs in from InEight Estimate that are not connected to
resources, for example, your plugged and/or quoted cost items. This tab is optional, and it is not
required to make selections here.

12.1.2 Schedule Cost Items

Before you can integrate with Primavera, your cost items need to be marked as Scheduled in InEight
Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views drop-
down list in the CBS, the Schedule Setup View displays all of your schedule-related columns. There are
a couple to keep in mind when you schedule your items:

l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.
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The following steps walk you through scheduling your cost items.

Step by Step — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it

3. Select the Mobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.
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Step by Step — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch
RCP Culvert Class.

To schedule all cost items, highlight the JOB row.

4. Right click on the selected rows and select Schedule Selection.
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l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then
click OK.
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l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.

12.1.2.6 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

Step by Step — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

12.1.3 Update Primavera from InEight Estimate

Now that you have set up your Primavera options in Job Properties and scheduled your cost items in
the CBS, you are ready to send your project information to Primavera.
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When you first update Primavera from InEight Estimate, Primavera will create a new project
automatically and load it with the following information from InEight Estimate:

Data Sent from InEight Estimate to Primavera

Data Type InEight Estimate Primavera

Project Data Job Code Project ID

Job Description Project Name

Activity Data CBS Position Code//Schedule ID WBS Code / Activity ID

Description WBS Element / Activity Name

Hours Planned Duration (Hours)

Shift and Rate Rules Activity Calendar

Cost Item Tags and UDFs Activity Codes or UDFs

Cost Category Total Cost Cost Category (custom text columns)

Resource Data Resource Code Resource ID

Resource Description Resource Name

Cost Data Resource Cost / Unit Resource Price / Unit

Cost Category Total Cost Expense Category Budgeted Cost

Tags, resource data, and cost data only update in Primavera if selected in the Job
Properties > Schedule settings.

The following steps walk you through updating Primavera from InEight Estimate to create a new
schedule.
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Step by Step — Update Primavera from InEight Estimate

1. From the Estimate tab, select Schedule>Update Primavera from InEight Estimate.

l The Update Primavera From Estimate dialog prompts you to indicate what data to update
to Primavera

2. Make sure Resources and Expenses are checked. Deselect Actuals (For Job Tracking purposes) if
auto selected, then click OK.
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l An Attention prompt appears, letting you know that the job has not been saved.

3. Click Yes to save the job before updating Primavera.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take several minutes
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l When the window disappears, the update is complete

4. Open Primavera P6 (Project Management) client.

5. Log in to Primavera, using the same Username and Password that was entered on the Schedule >
Login Options tab in InEight Estimate Job Properties.
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6. In Primavera, open the project.

Page 196 of 259 InEight Inc.  |  Release 20.2

12.1 Primavera Estimate Intermediate User Guide



7. In the Open Project dialog, expand the BID*BUILD folder.
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All projects created from InEight Estimate are created in the BID*BUILD folder by
default.

l Your available projects are sorted by their job names.

8. Select the Training Job (with your initials) so that it is highlighted, and then select Open.

l The WBS Layout displays for the project. You can see the breakdown structure imported
from InEight Estimate with durations, rolled up as specified by the Roll Up Schedule option
in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

9. Select the Resources tab to see the resources that imported for each activity, with their
associated costs.
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12.1.4 Update InEight Estimate from Primavera

You can also bring information back from Primavera into InEight Estimate. When you update InEight
Estimate from Primavera, the following information updates:

Update InEight Estimate from Primavera

Data Type Primavera InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Relationships Schedule Relationships

Hours Plugged Days
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Complete the following steps to practice updating InEight Estimate from Primavera. You will create a
scheduling relationship in Primavera, and then import the updated dates and relationships into InEight
Estimate.

Step by Step — Update InEight Estimate from Primavera

1. Open your version of the Training Job project in Primavera.

l In the real world, it is likely that you would have overlapping activities, or your activities
would occur out of order, however for this example you will link all activities from finish to
start

2. Highlight all of your activities from 1-Mobilization through 6.4-Backfill RCP Pipe.

3. Right click on one of the selected rows and select Link Selected Activities to create the Finish to
Start relationship.

l You may have to select the Relationship Lines button to show the linked activities in the
graph on the right side of the screen.

4. To schedule this new relationship, select the Schedule button (or press the F9 key).

5. On the Schedule Project window, keep the default settings and select the Schedule button.
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6. To update InEight Estimate with this change, go back to InEight Estimate and select Estimate tab.

7. Select Schedule>Update Estimate from Primavera.

8. On the Update InEight Estimate from Primavera prompt, keep the default Update the estimate
to stay in synch with the schedule selected, then click OK.
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9. On the Schedule Setup View, you can see the Start and Finish dates updated from Primavera.
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12.1.5 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.1.5.7 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab.

For example, your 10” PVC Pipe activity may have extra days in the schedule due to the delivery date
of the pipe material, but you don’t want those extra days to drive the costs in your estimate, since your
crews won’t be working on the activity on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.

Step by Step — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate-
Install-Backfill Pipe.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate-Install-Backfill Pipe
cost item, then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

12.1.5.8 Update Primavera with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.
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Step by Step — Update Primavera with InEight Estimate Changes

1. In the Training Job from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below:

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your
unit costs stay intact, then click OK.

3. From the Estimate tab, select Schedule>Update Primaverafrom InEight Estimate to send the
changed hours to Primavera.
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l The Update Primavera From InEight Estimate dialog prompts you to indicate what data to
update to Primavera

4. Make sure Resources and Expenses are checked, then select OK.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take a few minutes
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l When the window disappears, the update is complete

5. Open Primavera (P6 Web Client).

6. Open the Training Job project.

7. On the Activities screen, compare the Planned Duration to the Days (Duration driven) in InEight
Estimate for Excavate-Install-Backfill Pipe.

l The Primavera scheduled duration should have changed from 4.65 days to 7 days to match
the updated duration in InEight Estimate for Excavate-Install-Backfill Pipe

l You will also notice a change in days for Excavation after changing the T/O Quantity in
InEight Estimate
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8. To schedule this change in Primavera, select the Schedule button (or press the F9 key) and select
the Schedule button on the Schedule Project window.

9. Your start and finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule>Update InEight Estimate from Primavera to update InEight Estimate with the new
dates.
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Exercise 12.1 — Manage Changes Between Estimate and Primavera

As changes occur during the estimating process, you can keep the estimate and schedule in sync
through schedule integration. In this exercise, you will practice making changes between the
estimate and schedule. Complete the following steps:

1. Open the Training Job and open the CBS Register.

2. Check the box in the Schedule Plug Days column for the Install RCP Pipe.

3. Change the Plug Days for Install RCP Pipe to 8 days.

4. Update Primavera from InEight Estimate.

5. Open the Training Job project in Primavera and confirm the Planned Duration (you may
need to change your view to see this column) changed to 8 days.

6. In Primavera, change the Planned Duration for Backfill RCP Pipe to 12 days.

7. Schedule the changes in Primavera (Schedule button or F9).

8. Update InEight Estimate from Primavera.

You should end up with the following results

Cost item 6.3 Install RCP Pipe is now showing 8 Plug days in Primavera.
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Cost item 6.4 Backfill RCP Pipe should have 12 plug days in InEight Estimate.

Congratulations, you have completed this exercise!
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12.2 MICROSOFT PROJECT

12.2.1 Set Up Scheduling Options

Prior to sending information from InEight Estimate to Microsoft Project, you need to make sure the
proper settings are in place.

12.2.1.1 Job Properties Schedule Tab

Microsoft Project scheduling options are configured on the Schedule tab of the Job Properties form.

l At the top of the Schedule tab, the Integrated Schedule must be set toMicrosoft Project

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Microsoft Project to change the duration and therefore
the cost of your cost items in InEight Estimate)

12.2.2 Schedule Cost Items

Before you can integrate with Primavera, your cost items need to be marked as Scheduled in InEight
Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views drop-
down list in the CBS, the Schedule Setup View displays all of your schedule-related columns. There are
a couple to keep in mind when you schedule your items:
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l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

The following steps walk you through scheduling your cost items.

Step by Step — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it
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3. Select the Mobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.

Step by Step — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch
RCP Culvert Class.

To schedule all cost items, highlight the JOB row
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4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then
click OK.

l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.
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12.2.2.2 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

Step by Step — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

12.2.3 Update Microsoft Project from InEight Estimate

Now that you have set up your schedule to integrate with Microsoft Project in Job Properties and
scheduled your cost items in the CBS, you are ready to send your project information to Microsoft
Project.

When you first update Microsoft Project from InEight Estimate, Microsoft Project will create a new
project automatically and load it with the following information from InEight Estimate:
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Data Sent from InEight Estimate to Microsoft Project

Data Type InEight Estimate Microsoft Project

Project Data Job Code Project Name

Activity Data

CBS Position Code 01 – CBS Position Code

Description Description

Days (Duration Driven) Duration

Cost Data Cost Category Total Cost Cost Category (custom text columns)

The following steps walk you through updating Microsoft Project from InEight Estimate to create a new
schedule.
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Step by Step — Update MS Project from InEight Estimate

1. From the Estimate tab, select Schedule>Update Project from InEight Estimate.

l Your job automatically opens in Microsoft Project

l The Work Breakdown Structure Layout displays for the project

l You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
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Cover Sheet tab (these will change as activity relationships are defined)

12.2.4 Update InEight Estimate from Microsoft Project

You can also bring information back from Microsoft Project into InEight Estimate. When you update
InEight Estimate from Microsoft Project, the following information updates:

Update InEight Estimate from Microsoft Project

Data Type Microsoft Project InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Hours Hours

Walk through the following steps to practice updating InEight Estimate from Microsoft Project. You will
create a scheduling relationship in Microsoft Project and then import the updated dates and
relationships into InEight Estimate.
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Step by Step — Update InEight Estimate from MS Project

1. Open your version of the Training Job project in Microsoft Project.

l In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

l Ensure the Auto Schedule button is selected

3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate
tab, select Schedule>Update InEight Estimate from Project.
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l On the Schedule Setup View, you can see the Start and Finish dates updated from MS
Project.

12.2.5 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.2.5.3 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab. For example, your 10” PVC Pipe activity
may have extra days in the schedule due to the delivery date of the pipe material, but you don’t want
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those extra days to drive the costs in your estimate, since your crews won’t be working on the activity
on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.

Step by Step — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate RCP
Trench.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate RCP Trench cost item,
and then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

Any duration changes made in Project will import into InEight Estimate as Plug Days
automatically so that they can be reviewed by the estimator before making any changes to
production in InEight Estimate.

12.2.5.4 Update Microsoft Project with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.
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Step by Step — Update MS Project with InEight Estimate Changes

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your
unit costs stay intact

3. From the Estimate tab, select Schedule>Update Projectfrom InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.
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l The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench

l You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule >Update InEight Estimate from Project to update InEight Estimate with the new
dates.
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Lesson 12 Review

1. Under the Job Properties > Schedule tab, which setting can be enabled to account for
plugged costs (e.g., for subcontractors)?

a. Resource price/unit

b. Expense Costs

c. Schedule ID

d. Actuals

2. For InEight Estimate schedule integration with Primavera, which of the following can be
sent from your estimate to the schedule? (Select all that apply)

a. Activity data

b. Cash Flow graphs

c. Resource data

d. Cost data

e. Price data

3. The Schedule Plug Days option allows you to define the duration in the schedule separate
from the duration defined for your cost items on the Production tab.

a. True

b. False

Lesson 12 Summary

As a result of this lesson, you can:

l Set up scheduling options

l Update Schedule from InEight Estimate

l Update InEight Estimate from Schedule

l Manage changes between estimate and schedule
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LESSON 13 — CASH FLOW

Lesson Duration: 25 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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13.1 CASH FLOW

The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either
directly from integration with Primavera, Microsoft project, or input manually.

Overview – Cash Flow Form

Section Description

1
The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.

l The x-axis measures time
l The left y-axis measures amounts
l The right y-axis measures quantities (when resource utilization is displayed)
l All graphs depicted on the Cash Flow form can be displayed based on Pay Quantity

or Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.
l You can display total costs and price or specific cost categories
l You can also set the display settings to report on Resource Utilization

3
Click on the Cash Flow Options icon to specify revenue timing, cost timing, and cost of
money.

4 Click the Excel icon to export the numerical data represented on the graph into an Excel
spreadsheet where you can run additional analysis.

5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset Zoom
button to restore the graph to its original state.
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13.2 CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options icon in the Tools section of the
Actions tab.

You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.
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1. Revenue timing:  Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing:  Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

To include any of your costs in your cash flow (including indirect costs), they need
to be scheduled

3. Cost of Money:  Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/O)
quantities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses,
revenue, and costs that show up on the Cash Flow graph. You have the option to base cash flow
timing on Start/Finish dates or Late Start/Finish dates.
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13.2.0.1 Cash Flow Options Set Up

The following steps walk you defining settings on the Cash Flow Options form.

Step by Step — Cash Flow Options Setup

1. In the E101 – Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

l You will see the default options already there

l You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.
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l The average calendar days from billing to collection should be set to 25 days

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

l Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

5. Leave all remaining options as originally defaulted.
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13.3 CASH FLOW DISPLAY SETTINGS

13.3.1

13.3.2 Cost Items and Cost Categories

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
To open the Display Settings click on the Actions > Display Settings icon in the Tools section.

Section Description

1 You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include:  Day,
Week, Month, Quarter, and Year.

3

Under the Cost Items section, you can select:
l Total Cost (Forecast):  The total cost of your scheduled cost items, based on when

your costs are accrued (when your cost items are scheduled). This is displayed as a
dashed line on the graph

l Total Price (current):  The total revenue of your pay items, based on when the
revenue is earned (when your cost items are scheduled). This is displayed as a
dashed line on the graph

l Total Cost (Forecast) – Cash:  The total cost of your scheduled cost items, reflecting
the cost timing you specify in the Cash Flow Options. This is displayed as a solid line
on the graph

l Total Price (current) – Cash:  The total revenue of the pay items, reflecting the
revenue timing you specify in the Cash Flow Options. This is displayed as a solid line
on the graph

l Cash Flow:  Displays the difference between your Total Cost – Cash and Total Price
– Cash values, so you can see if you are making or losing money

l Finance Cost:  Displays the Cost of Money amount calculated from the settings you
specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to display.
l The other check boxes are used for InEight Estimate Performance

Overview – Cash Flow Display Settings – Cost Items and Cost Categories
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13.3.2.1 Cash Flow Display Set Up

The following steps walk you through setting up your Cash Flow Display Settings.

Step by Step — Cash Flow Display Settings Set Up

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. From the Period drop-down list, selectWeek.

4. Under the Cost Items section, make sure the following are selected:

l Total Cost (Forecast)

l Total Price (Forecast)

l Total Cost (Forecast) – Cash

l Total Price (Forecast) – Cash

l Cash Flow
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l Finance Cost

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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6. Click OK to close the Display Settings window.

l Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

l Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

l Your Total Cost (Forecast) – Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

l Your Total Price (current) – Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

l Your Cash Flow displays grey bars indicating when your cash flow is negative or positive

Page 234 of 259 InEight Inc.  |  Release 20.2

13.3 Cash Flow Display Settings Estimate Intermediate User Guide



l Your Finance Cost displays as a blue line on the graph

7. To filter your graph by date range, click on the Start drop-down arrow and select a start date
of your date range filter.

8. Click on the End drop-down arrow and select an end date of your date range filter.
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l Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10. Do the same for the End field.

13.3.3 Resource Utilization

You can also use the Cash Flow graph to report on resource utilization. For example, you may want to
run a report that displays a work hours curve for a particular labor trade or to see the peak usage
times for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:

l Resource Type

l Resource Code

l Description

l Organizational Category

l Tag 1, 2, and 3

l Quote Group

l Account Code and Cost Item Account Code

l Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for setting
up Cash Flow, Display Settings in the Tools section of the Actions menu.
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13.3.3.2 Resource Utilization Display Set Up

The following steps walk you through setting up your Cash Flow graph to report on Resource
Utilization.

Step by Step — Resource Utilization Display Setup

1. In the E101 – Training Job, from the Estimate tab, select CashFlow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.

4. Under the Resources section, check the Resource Utilization checkbox.

5. From the Summarize resources by drop-down list, select Description.
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6. From the resulting list of Values, select Laborer.

7. Click in the Qty field for the selected value and select a color of your choice.

l In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a
Line.
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10. Click OK to close the Display Settings window.

l The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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Lesson 13 Review

1. Under what cash flow form can you set up your revenue and cost timing?

a. Cash Flow Options

b. Display Settings

c. Worksheet

d. Page Setup

2. By default, the red dashed line on the Cash Flow graph represents the:

a. Total Cost (Forecast)

b. Total Price (current)

c. Total Cost (Forecast) – Cash

d. Total Price (current) - Cash

3. In the Cash Flow Display Settings, Resource Utilization allows you to view a graphical
summarization of your resources by which of the following? (Select all that apply)

a. Resource File Description

b. Resource Type

c. Resource Code

d. Description

e. Wage Zone

f. Organizational Category

Lesson 13 Summary

As a result of this lesson, you can:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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LESSON 14 — INEIGHT ESTIMATE
CALCULATORS

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator
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14.1 HAUL CALCULATOR

The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

l Calculate the number of trucks required to complete the haul in a set amount of time, or

l Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

Step by Step — Haul Calculator – Calculate Quantity of Trucks

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.
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5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in
duration entered below radio button. (ETDT is the resource code for the Dump Truck you
selected.)

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35Mile/Hour.
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10. For Dump Time (Minutes), type 2.

11. Enter a Travel Speed Empty of 45Mile/Hour. Notice this calculates a cycle time of 20.24.

12. Enter a Work Efficiency of 90 percent.
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l The calculator shows a result of 1.56 concurrent haulers

13. Click OK.

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the
Teamster Quantity to 2 (if needed).

Step by Step — Haul Calculator – Calculate Total Duration

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Change your Teamster and Dump Truck quantities back to 2 each.

5. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

6. On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

l With the previous information you entered still there, the calculator calculates a total
duration of 281.08 hours
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7. Click OK.

l The Hours field on the Production tab updated to 281.08

l Your ETDT Dump Truck quantity remains at 2

14.2 TRENCH CALCULATOR

The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge
elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:

l Total excavation volume (neat-line)

l Total excavation volume (including swell/shrinkage)
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l Total pipe to purchase

l Lift Volume (for up to four beddings)

l Lift Weight (for up to four beddings)

You can use these calculations to define certain cost item setup data:

l You can use the Total Excavation Volume that is calculated as the quantity of the cost item

l You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

l You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

l You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

You can access the Trench Calculator from the Actions tab of a Cost Item Record

When copying cost items in a job or from job to job, the Trench Calculator variable data
is included with the data being copied. When a cost item is copied to the clipboard,
Trench Calculator variable data is also included.

14.2.1 Trench Calculator – Trench Tab

The following steps walk through using the Trench Calculator to take-off excavation volume.

Step by Step — Trench Calculator – Trench

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.

3. Add the following three subordinates and update their Units of Measure:

l Excavate Trench: CY

l Install Pipe: LF

l Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:
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l LL2  Laborer – 1

l LO2  Operator Class 2 – 1

l EX245  Excavator 245 – 1

5. Adjust the Production to: 100 CY/Hour.

6. On the Cost Item Record’s Actions tab, select Trench Calculator.

7. For Trench Length, type 1000.00 feet.

8. For Trench Width (at the bottom) type 4.00 feet.

9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.
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11. Enter a Backslope of 45 degrees.

12. Define the Material Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.

l You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.

14. Click Save Configuration to Library and save the Trench calculator as Trench Example with
your initials.

15. Click OK.

14.2.2 Trench Calculator – Pipe Tab

You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.
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Step by Step — Trench Calculator – Pipe

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

l Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.

4. On the Cost Item Record’s Actions tab, select Trench Calculator.

5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

7. Click OK.

8. On the Trench Calculator, select the Pipe tab.

9. Enter the following for the size and position of the pipe:

l Pipe exterior diameter:  26.00 inches

l Pipe center elevation (from bottom):  19.00 inches

l Waste factor: 10%

10. Click on the resource icon to pull up the Resource Rate Register.

11. Select the Installed Material tab.

12. SelectMPP24 Pipe 24” PVC SDR35, then click OK.

l The Pipe variables you entered should match the following image:
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13. Click Save Configuration to Library and save the Trench calculator as Trench Example with
your initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

14.2.3 Trench Calculator – Beddings Tab

The following steps walk you using the Trench Calculator to calculate bedding take-offs.

Step by Step — Trench Calculator – Beddings

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.
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3. Add the following resources:

l LL2 Laborer – 3

l LO2 Operator Class 2 – 1

l RPC Plate Compactor – 1 

l EL950 Loader 950 – 1

4. Adjust the Production to 160 CY/Day.

5. From the Cost Item Record’s Actions tab, select Trench Calculator.

6. Select Load Configuration from Library

7. Select Trench Example (with your initials), then click OK.

8. On the Trench Calculator, select the Beddings tab.

9. On the Beddings tab, you can define up to four beddings to backfill the trench

l The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

Bedding Lift 1 Bedding Lift 2 Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00

Additional material needed 5.00 5.00 5.00

Conversion factor 1.60 1.70 1.60

l Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:

Resource Code Resource Description

Bedding Lift 1 MASAND Sand

Bedding Lift 2 MAFA Fine Aggregate

Bedding Lift 3 MACA1-1/2 Coarse Aggregate
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12. Click OK.

l Note that the pipe and bedding materials are added to the cost item with their quantities
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Exercise 14.1 — Trench Calculator

In this exercise, you will practice using the Trench Calculator to take-off piping and bedding
materials. Complete the following steps:

1. In the Training Job, create a new cost item called Underground Pipe.

2. Give the cost item a quantity and unit of measure of 1640 Linear Feet.

3. Open the new cost item and open the Trench Calculator.

4. On the Trench tab, enter the variables for the trench:

Trench length 1000 feet

Trench width (at bottom) 4 feet

Trench depth 10 feet

Hinge elevation 5 feet

Backslope 45 degrees

Material swell/shrinkage factor 0.10 (decimal)

l Do NOT check the box to bring in volume shrinkage.

5. Select the MPR36 material resource from the drop-down Results list.

6. On the Beddings tab, enter bedding variables.

Bedding lift 1

Elevation (from trench floor) 6 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.3
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Bedding lift 1

Bedding material resource (Tons) MASAND

Bedding lift 2

Elevation (from trench floor) 38 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MAFA

Bedding lift 3

Elevation (from trench floor) 76 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MACA1-1/2

7. Select OK and confirm that the pipe material and bedding materials populated the cost
item.

You should end up with the following results
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Congratulations, you have completed this exercise!
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14.3 IN-FIELD CALCULATOR

You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by inserting
the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed by
a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much
sandblasting is needed for painting the steel bridge structure specified in the Training Job.

The resulting field value is stored without the arithmetic expression used to calculate the
value.

Step by Step — In-Field Calculator

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Scroll to find cost item 13.3 Sandblast.

3. Click in the Forecast (T/O) Quantity field.

4. Press the = key, then type 10*250.
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5. Press the Tab key and it calculates the result.
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Lesson 14 Review

1. The Haul calculator allows you to:

a. Calculate the number of trucks required to complete the haul in a set amount of
time

b. Calculate how long it will take to complete the haul with a set number of trucks

c. Neither

d. Both

2. The Trench Calculator allows you to quickly calculate ___________ values.

a. Trench

b. Pipe

c. Bedding

d. All of the above

3. For the in-field calculator, what symbol needs to be at the beginning of the math
equation for it to calculate?

a. +

b. –

c. =

d. (

Lesson 14 Summary

As a result of this lesson, you can:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator
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